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Question Number : 1 Question Id : 146587301 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The Bastar highland, known as _______, lies south of Chhattisgarh basin.
Options :
1465871201.  Raigarh Plateau
1465871202.  Maikal Caves
1465871203.  Dandakaranya
1465871204.  Dharamjaigarh
  
Question Number : 1 Question Id : 146587301 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
ब�र उ� भूिम (Bastar highland), िजसे _______ के नाम से जाना जाता है, छ�ीसगढ़ बेिसन के दि�ण म� ��थत है।
Options :
1465871201.  रायगढ़ पठार
1465871202.  मैकाल गुफाएं
1465871203.  दंडकार�



1465871204.  धम�जयगढ़
  
Question Number : 2 Question Id : 146587302 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
According to Agro-Climatic Zones of Chhattisgarh, _________ district is situated in the Chhattisgarh Plains.
Options :
1465871205.  Balrampur
1465871206.  Jashpur
1465871207.  Sukma
1465871208.  Durg
  
Question Number : 2 Question Id : 146587302 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ के कृिष-जलवायु ज़ोन के अनुसार, _________ िजला छ�ीसगढ़ के मैदानो ंम� ��थत है।
Options :
1465871205.  बलरामपुर
1465871206.  जशपुर
1465871207.  सुकमा
1465871208.  दुग�
  
Question Number : 3 Question Id : 146587303 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
What is the name of the renowned freedom fighter who launched the monthly magazine 'Chhattisgarh Mitra' in the year 1900?
Options :
1465871209.  Pandit Madhav Rao Sapre
1465871210.  Hanuman Singh
1465871211.  Narain Singh
1465871212.  Babu Chhotey Lal Shrivastava



  
Question Number : 3 Question Id : 146587303 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
वष� 1900 म� मािसक पि�का 'छ�ीसगढ़ िम�' का िज�ों�ने शुभारंभ िकया था, उस �िस� �तं�ता सेनानी का नाम �ा है?
Options :
1465871209.  पंिडत माधव राव स�े
1465871210.  हनुमान िसंह
1465871211.  नारायण िसंह
1465871212.  बाबू छोटे लाल �ीवा�व
  
Question Number : 4 Question Id : 146587304 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The Kabir panthis came to Chhattisgarh in ________ period.
Options :
1465871213.  The Gupta Period
1465871214.  The Satavahana Period
1465871215.  The Mughal
1465871216.  The Khalji
  
Question Number : 4 Question Id : 146587304 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
कबीर पंथी ________ अविध म� छ�ीसगढ़ आए।
Options :
1465871213.  गु� काल
1465871214.  सातवाहन काल
1465871215.  मुगल
1465871216.  �खलजी
  



Question Number : 5 Question Id : 146587305 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
When the Halba rebellion was started?
Options :
1465871217.  1855
1465871218.  1774
1465871219.  1798
1465871220.  1832
  
Question Number : 5 Question Id : 146587305 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
हलबा िव�ोह कब शु� �आ था?
Options :
1465871217.  1855
1465871218.  1774
1465871219.  1798
1465871220.  1832
  
Question Number : 6 Question Id : 146587306 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which day is observed as Chhattisgarhi Rajbhasha Diwas since 2007, when Chhattisgarhi was given the status of state language in the Vidhan
Sabha?
Options :
1465871221.  28th May
1465871222.  28th July
1465871223.  28th September
1465871224.  28th November
  
Question Number : 6 Question Id : 146587306 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option



Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
2007 के बाद िकस िदन को छ�ीसगढ़ी राजभाषा िदवस के �प म� मनाया जाता है, जब छ�ीसगढ़ी को िवधानसभा म� रा� भाषा का दजा� िदया गया था?
Options :
1465871221.  28 मई
1465871222.  28 जुलाई
1465871223.  28 िसतंबर
1465871224.  28 नवंबर
  
Question Number : 7 Question Id : 146587307 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which festival of Chhattisgarh is committed to the reverence of 'Mother Earth'?
Options :
1465871225.  Kajari Festival
1465871226.  Goncha Festival
1465871227.  Surhul Festival
1465871228.  Madai Festival
  
Question Number : 7 Question Id : 146587307 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ का कौन सा �ौहार 'धरती माता' की ��ा म� मनाया जाता है?
Options :
1465871225.  कजरी महो�व
1465871226.  गोचंा महो�व
1465871227.  सर�ल महो�व
1465871228.  मड़ई महो�व
  
Question Number : 8 Question Id : 146587308 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0
With which dance form was the famous folk dancer Devdas Banjare associated?
Options :
1465871229.  Raut Nacha
1465871230.  Panthi Dance
1465871231.  Rahas
1465871232.  Hareli
  
Question Number : 8 Question Id : 146587308 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
�िस� लोकनत�क देवदास बंजारे िकस नृ� शैली से जुड़े थे?
Options :
1465871229.  राउत नाचा
1465871230.  पंथी डांस
1465871231.  रहस
1465871232.  हरेली
  
Question Number : 9 Question Id : 146587309 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following ornaments of Chhattisgarh is worn in the nose?
Options :
1465871233.  Phulli/Phuli
1465871234.  Ainthi
1465871235.  Tilari
1465871236.  Nangamori
  
Question Number : 9 Question Id : 146587309 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ का िन�िल�खत कौन सा आभूषण नाक म� पहना जाता है?



Options :
1465871233.  फु�ी
1465871234.  ऐठंी
1465871235.  ितलरी
1465871236.  नंगामोरी
  
Question Number : 10 Question Id : 146587310 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
With which singing style was the noted singer Suruj Bai Khande associated?
Options :
1465871237.  Pandavani
1465871238.  Goura
1465871239.  Khaduwa
1465871240.  Bharthari
  
Question Number : 10 Question Id : 146587310 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िकस गायन शैली से ��ात गाियका सु�ज बाई खांडे जुड़ी थी?ं
Options :
1465871237.  पंडवानी
1465871238.  गौरा
1465871239.  खडुवा
1465871240.  भरथरी
  
Question Number : 11 Question Id : 146587311 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
As per the provisions of the Constitution of India, in order to be appointed as the Governor of Chhattisgarh, what is the minimum age required?
Options :



1465871241.  25
1465871242.  30
1465871243.  35
1465871244.  40
  
Question Number : 11 Question Id : 146587311 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
भारत के संिवधान के �ावधानो ंके अनुसार छ�ीसगढ़ के रा�पाल के �प म� िनयु� होने के िलए आव�क �ूनतम आयु की �ा है?
Options :
1465871241.  25
1465871242.  30
1465871243.  35
1465871244.  40
  
Question Number : 12 Question Id : 146587312 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The advocate general of the state of Chhattisgarh is appointed by the _________.
Options :
1465871245.  Chief Justice of High Court
1465871246.  Chief Minister of Chhattisgarh
1465871247.  Governor of Chhattisgarh
1465871248.  Chief Justice of Supreme Court
  
Question Number : 12 Question Id : 146587312 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ रा� के महािधव�ा (एडवोकेट जनरल) को ________ के �ारा िनयु� िकया जाता है।
Options :
1465871245.  उ� �ायालय के मु� �ायाधीश



1465871246.  छ�ीसगढ़ के मु�मं�ी
1465871247.  छ�ीसगढ़ के रा�पाल
1465871248.  सु�ीम कोट� के मु� �ायाधीश
  
Question Number : 13 Question Id : 146587313 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Under Article 213 of the Constitution, when the House is not in session, if the Government wants to introduce any law, he/she issues _________,
which contains legal provisions.
Options :
1465871249.  ordinance
1465871250.  injunction
1465871251.  ruling
1465871252.  protocol
  
Question Number : 13 Question Id : 146587313 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
संिवधान के अनु�ेद 213 के तहत, जब सदन स� म� नही ंहोता है, यिद सरकार कोई कानून लागू करना चाहती है, तो वह ________ जारी करती है, िजसम�
कानूनी �ावधान शािमल ह�।
Options :
1465871249.  अ�ादेश
1465871250.  आदेश
1465871251.  स�ा�ढ़
1465871252.  �ोटोकॉल
  
Question Number : 14 Question Id : 146587314 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Who presides over the House in the absence of the Speaker?
Options :
1465871253.  Chief Minister



1465871254.  Home Minister
1465871255.  Member from the Panel of Chairman
1465871256.  Governor
  
Question Number : 14 Question Id : 146587314 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
�ीकर (Speaker) की अनुप��थित म� सदन की अ��ता कौन करता है?
Options :
1465871253.  मु�मं�ी
1465871254.  �ह मं�ी
1465871255.  चेयरमैन के पैनल से सद�
1465871256.  रा�पाल
  
Question Number : 15 Question Id : 146587315 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
How many coal fields are there in Chhattisgarh?
Options :
1465871257.  9
1465871258.  10
1465871259.  12
1465871260.  14
  
Question Number : 15 Question Id : 146587315 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ म� कुल िकतने कोयला �े� ह�?
Options :
1465871257.  9
1465871258.  10



1465871259.  12
1465871260.  14
  
Question Number : 16 Question Id : 146587316 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Iron ore deposits of Chhattisgarh are associated with the rocks that are world over known to contain:
Options :
1465871261.  Magnetite
1465871262.  Hematite
1465871263.  Limonite
1465871264.  Siderite
  
Question Number : 16 Question Id : 146587316 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ के लोह अय� भंडार उन च�ानो ंसे जुड़े ह�, िज�� दुिनया भर म� के �प म� जाना जाता है:
Options :
1465871261.  मै�ेटाइट (Magnetite)
1465871262.  हेमेटाइट (Hematite)
1465871263.  िलमोनाइट (Limonite)
1465871264.  िसडेराइट (Siderite)
  
Question Number : 17 Question Id : 146587317 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The aluminium extraction plant of BALCO is operational at which district of Chhattisgarh ?
Options :
1465871265.  Bilaspur
1465871266.  Raipur
1465871267.  Sukma



1465871268.  Korba
  
Question Number : 17 Question Id : 146587317 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ रा� का बा�ो (BALCO) का ए�ूमीिनयम िन�ष�ण �ांट _______ िजले म� काय�रत है।
Options :
1465871265.  िबलासपुर
1465871266.  रायपुर
1465871267.  सुकमा
1465871268.  कोरबा
  
Question Number : 18 Question Id : 146587318 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In the NITI Aayog's ''Healthy States, Progressive India" list released in June 2019, under which category does the state of Chhattisgarh figure?
Options :
1465871269.  Front-runners
1465871270.  Achievers
1465871271.  Aspirants
1465871272.  Laggards
  
Question Number : 18 Question Id : 146587318 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
जून 2019 म� जारी �ई नीित आयोग की "��थ रा�, �गितशील भारत" की सूची म� छ�ीसगढ़ रा� िकस �ेणी के अंतग�त आता है?
Options :
1465871269.  �ंट रनस�
1465871270.  अचीवस�
1465871271.  आकां�ी
1465871272.  िफस�ी



  
Question Number : 19 Question Id : 146587319 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Maria revolt, one of the major tribal rebellions, took place during which of the following years? 

Options :
1465871273.  1870-1881
1465871274.  1814-1835
1465871275.  1842-1863
1465871276.  1881-1892
  
Question Number : 19 Question Id : 146587319 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
मे�रया/मािड़या िव�ोह (Maria revolt), जो िक �मुख आिदवासी िव�ोहो ंम� से एक है, िन�िल�खत म� से िकन वष� के दौरान �आ?
Options :
1465871273.  1870-1881
1465871274.  1814-1835
1465871275.  1842-1863
1465871276.  1881-1892
  
Question Number : 20 Question Id : 146587320 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Who among the following led the revolt of Paralkot?
Options :
1465871277.  Thakur Pyarelal Singh
1465871278.  Gend Singh
1465871279.  Gopinath Kapardas
1465871280.  Vir Narain Singh



  
Question Number : 20 Question Id : 146587320 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से िकसने परलकोट के िव�ोह का नेतृ� िकया था?
Options :
1465871277.  ठाकुर �ारेलाल िसंह
1465871278.  ग�द िसंह
1465871279.  गोपीनाथ कपरदास
1465871280.  वीर नारायण िसंह
  
Question Number : 21 Question Id : 146587321 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which among the following is the state agency engaged in the exploration of mineral resources in Chhattisgarh?
Options :
1465871281.  Chhattisgarh Environment Conservation Board
1465871282.  Indian Bureau of Mines
1465871283.  Directorate of Geology and Mining
1465871284.  Container Freight Depot
  
Question Number : 21 Question Id : 146587321 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सी एक रा� एज�सी है जो छ�ीसगढ़ म� खिनज संसाधनो ंकी खोज म� लगी �ई है?
Options :
1465871281.  छ�ीसगढ़ पया�वरण संर�ण मंडल
1465871282.  भारतीय खान �ूरो
1465871283.  भूिव�ान और खनन िनदेशालय (Directorate of Geology and Mining)
1465871284.  कंटेनर �ेट िडपो (Container Freight Depot)
  



Question Number : 22 Question Id : 146587322 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The famous play 'Unch Neech' is written by which author of Chhatisgarh?
Options :
1465871285.  Khub Chand Baghel
1465871286.  Ambar Shukla
1465871287.  Tejpal Soni
1465871288.  Shiva Bajpai
  
Question Number : 22 Question Id : 146587322 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
�िस� नाटक 'ऊंच नीच' छ�ीसगढ़ के िकस लेखक ने िलखा है?
Options :
1465871285.  खूबचंद बाघेल
1465871286.  अ�र शु�ा
1465871287.  तेजपाल सोनी
1465871288.  िशवा बाजपेयी
  
Question Number : 23 Question Id : 146587323 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The pithora style of Chhattisgarh tribe is type of ______.
Options :
1465871289.  Wood carving
1465871290.  Painting
1465871291.  Metal Carving
1465871292.  Dance
  
Question Number : 23 Question Id : 146587323 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ जनजाित की िपथोरा शैली एक �कार की/का ______ होती/होता है।
Options :
1465871289.  लकड़ी पर न�ाशी
1465871290.  िच�कारी
1465871291.  धातु पर न�ाशी
1465871292.  नृ�
  
Question Number : 24 Question Id : 146587324 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
As per FSI report 2017, what percentage (approximate) of total area of Chhattisgarh is covered under forests?
Options :
1465871293.  41.33%
1465871294.  25.97%
1465871295.  12.28%
1465871296.  59.25%
  
Question Number : 24 Question Id : 146587324 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
FSI की �रपोट� 2017 के अनुसार, छ�ीसगढ़ के कुल �े�फल का िकतना �ितशत (अनुमािनत) �े� वनो ंके अंतग�त आता है?
Options :
1465871293.  41.33%
1465871294.  25.97%
1465871295.  12.28%
1465871296.  59.25%
  
Question Number : 25 Question Id : 146587325 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Where is CHIRIMIRI coal field located in Chhattisgarh?



Options :
1465871297.  Dhantewada district
1465871298.  Korea district
1465871299.  Durg district
1465871300.  Surajpur district
  
Question Number : 25 Question Id : 146587325 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छ�ीसगढ़ म� िच�रिमरी कोयला �े� कहाँ ��थत है?
Options :
1465871297.  दंतेवाड़ा िजला
1465871298.  को�रया िजला
1465871299.  दुग� िजला
1465871300.  सूरजपुर िजला
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Question Number : 26 Question Id : 146587326 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0
Which of the following input devices is used where one out of a few alternatives is to be selected and marked using a pen or pencil?
Options :
1465871301.  MICR device
1465871302.  OMR device
1465871303.  Barcode reader
1465871304.  Digitiser
  
Question Number : 26 Question Id : 146587326 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
जब कुछ िवक�ो ंम� से िकसी एक को पेन या प��िसल का �योग कर चयिनत और िचि�त िकया जाना हो, तो िन�िल�खत म� से िकस इनपुट िडवाइस का उपयोग
िकया जाता है?
Options :
1465871301.  MICR िडवाइस
1465871302.  OMR िडवाइस
1465871303.  बारकोड रीडर
1465871304.  िडिजटाइज़र
  
Question Number : 27 Question Id : 146587327 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following keys is used to generate a 'new line' character?
Options :
1465871305.  Tab
1465871306.  Enter
1465871307.  Shift
1465871308.  Ctrl
  
Question Number : 27 Question Id : 146587327 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



‘�ू लाइन’ कैरे�र (सं�तीक) बनाने के िलए िन�िल�खत म� से िकस कंुजी (की) का उपयोग िकया जाता है?
Options :
1465871305.  Tab
1465871306.  Enter
1465871307.  Shift
1465871308.  Ctrl
  
Question Number : 28 Question Id : 146587328 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is/are TRUE?

(i) CRT stands for Cathode-Ray Tube.
(ii) LCD is a non-emissive display device.
Options :
1465871309.  Only (i)
1465871310.  Only (ii)
1465871311.  Both (i) and (ii)
1465871312.  Neither (i) nor (ii)
  
Question Number : 28 Question Id : 146587328 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा/से कथन स� है/ह�?

(i) CRT का पूण� �प Cathode-Ray Tube (कैथोड-रे �ूब) है।
(ii) LCD एक गैर-उ�ज�क (non-emissive) िड��े िडवाइस है।
Options :
1465871309.  केवल (i)
1465871310.  केवल (ii)
1465871311.  (i) और (ii) दोनों
1465871312.  न तो (i) और ना ही (ii)



  
Question Number : 29 Question Id : 146587329 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is FALSE?
Options :
1465871313.  A CPU contains an ALU, a CU, and registers.
1465871314.  An ALU does all the arithmetic and logic calculations.
1465871315.  A CPU is also called the tertiary storage of a computer system.
1465871316.  A CU controls the functioning of the hardware units of a computer system.
  
Question Number : 29 Question Id : 146587329 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा कथन अस� है?
Options :
1465871313.  CPU म� ALU, CU और रिज�र होते ह�।
1465871314.  ALU सभी अंकगिणतीय एवं तक�  गणनाएँ करता है।
1465871315.  CPU को कं�ूटर िस�म का तृतीयक सं�हण (�ोरेज) भी कहा जाता है।
1465871316.  CU कं�ूटर िस�म की हाड�वेयर इकाइयो ंके काय�/फं�न को िनयंि�त करता है।
  
Question Number : 30 Question Id : 146587330 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
With respect to CPU registers, PC stands for:
Options :
1465871317.  Program Counter
1465871318.  Program Carrier
1465871319.  Parallel Counter
1465871320.  Parallel Carrier
  
Question Number : 30 Question Id : 146587330 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option



Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
CPU रिज�र के संबंध म�, PC का पूण� �प _________ है।
Options :
1465871317.  Program Counter (�ो�ाम काउंटर)
1465871318.  Program Carrier (�ो�ाम कै�रयर)
1465871319.  Parallel Counter (पैरेलल काउंटर)
1465871320.  Parallel Carrier (पैरेलल कै�रयर)
  
Question Number : 31 Question Id : 146587331 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following options best describes the truthfulness of the below statements?

(i) Both RAM and ROM are random access memory.
(ii) EPROM and EEPROM are exactly same.
Options :
1465871321.  (i) - TRUE; (ii) - TRUE
1465871322.  (i) - TRUE; (ii) - FALSE
1465871323.  (i) - FALSE; (ii) - TRUE
1465871324.  (i) - FALSE; (ii) - FALSE
  
Question Number : 31 Question Id : 146587331 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िदए गए िवक�ो ंम� से कौन सा िवक� िन�िल�खत कथनो ंकी स�ता का सव��म वण�न करता है?

(i) RAM और ROM दोनो ंर�डम ए�ेस (या���क अिभगम) मेमोरी ह�।
(ii) EPROM और EEPROM िबलकुल एक जैसे होते ह�।
Options :
1465871321.  (i) - स�; (ii) - स�
1465871322.  (i) - स�; (ii) - अस�



1465871323.  (i) - अस�; (ii) - स�
1465871324.  (i) - अस�; (ii) - अस�
  
Question Number : 32 Question Id : 146587332 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following software was developed by Microsoft?
Options :
1465871325.  OpenOffice
1465871326.  Linux
1465871327.  iOS
1465871328.  PowerPoint 2013
  
Question Number : 32 Question Id : 146587332 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा सॉ�वेयर Microsoft (माइ�ोसॉ�) �ारा िवकिसत िकया गया था?
Options :
1465871325.  OpenOffice
1465871326.  Linux
1465871327.  iOS
1465871328.  PowerPoint 2013
  
Question Number : 33 Question Id : 146587333 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In Microsoft Excel 2013, arrange the following steps in the CORRECT sequence by which one can insert existing comments and notes in one
cell to another cell.

a) Go to the 'Home' tab -> Click the arrow below 'Paste' -> Click 'Paste Special'.
b) Select the cell/cells that contain the comments that you want to copy -> Press Ctrl + C and click the destination cell.
c) To cancel the moving border, click another cell or press Esc.
d) In the 'Paste Special' dialog box, under Paste, click 'Comments' -> Click 'OK'.



Options :
1465871329.  b); a); d); c)
1465871330.  a); b); d); c)
1465871331.  b); a); c); d)
1465871332.  b); d); a); c)
  
Question Number : 33 Question Id : 146587333 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2013 म� िन�िल�खत चरणो ंको सही �म म� �व��थत कर� , िजससे कोई ��� एक सेल से दूसरे सेल म� मौजूदा िट�णी (कम�ट) और नोट
इ�ट� कर सके।

a) 'Home (होम)' टैब पर जाकर-> 'Paste (पे�)' के नीचे ऐरो (तीर के िनशान) पर ��क कर�  -> 'Paste Special (पे� �ेशल)' पर ��क कर�।
b) उस सेल / सेलो ंको सेले� कर�  िजसम� ऐसी िट�िणयाँ हो,ं िज�� आप कॉपी करना चाहते ह� -> Ctrl + C दबाएँ और गंत� सेल (destination cell) पर ��क
कर�।
c) मोिवंग बॉड�र को र� करने के िलए, िकसी अ� सेल पर ��क कर�  या Esc दबाएँ।
d) 'Paste Special (पे� �ेशल)' डायलॉग बॉ� म�, पे� के तहत, 'Comments (कॉमे�्स)' पर ��क कर�  -> 'OK (ओके)' पर ��क कर�।
Options :
1465871329.  b), a), d), c)
1465871330.  a), b), d), c)
1465871331.  b), a), c), d)
1465871332.  b), d), a), c)
  
Question Number : 34 Question Id : 146587334 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
State whether the following statements related to Excel are TRUE or FALSE.

a) You need to use the VLOOKUP function to find things in a table or a range by row.
b) FINDB function counts each double-byte character as 2 when you have enabled the editing of a language that supports DBCS and then set it as
the default language (Excel 2013).
c) The FV function returns the present as well as the future value of an investment.
Options :
1465871333.  a) – True; b) – True; c) – False



1465871334.  a) – True; b) – True; c) – True
1465871335.  a) – False; b) – True; c) – False
1465871336.  a) – True; b) – False; c) – False
  
Question Number : 34 Question Id : 146587334 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से सही या गलत कथन �� कीिजए।

a) आपको िकसी तािलका या पं��-िव�ार म� कुछ खोजने के िलए VLOOKUP फ़ं�न का उपयोग करना ज�री है।
b) जब आपने DBCS की समथ�क ल��ेज के संपादन को इनेबल िकया है और िफर इसे िडफ़ॉ� भाषा (Excel 2013) के �प म� सेट िकया है तब FINDB
फ़ं�न ��ेक डबल-बाइट कैरे�र को 2 के �प म� िगनता है।
c) FV फ़ं�न इनवे�म�ट के वत�मान के साथ ही भिव� के मान को �रटन� करता है।
Options :
1465871333.  a) – सही; b) – सही; c) – गलत
1465871334.  a) – सही; b) – सही; c) – सही
1465871335.  a) – गलत; b) – सही; c) – गलत
1465871336.  a) – सही; b) – गलत; c) – गलत
  
Question Number : 35 Question Id : 146587335 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In Microsoft Powerpoint 2013, which of the following options is NOT present in the 'Slides' group menu under the 'Home' tab?
Options :
1465871337.  Layout
1465871338.  Reset
1465871339.  Section
1465871340.  Clipboard
  
Question Number : 35 Question Id : 146587335 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



Microsoft PowerPoint 2013 म�, 'Home (होम)' टैब के तहत 'Slides (�ाइड)' �ुप मेनू म� िन�िल�खत म� से कौन सा िवक� नही ंरहता है?
Options :
1465871337.  Layout (लेआउट)
1465871338.  Reset (�रसेट)
1465871339.  Section (से�न)
1465871340.  Clipboard (��पबोड�)
  
Question Number : 36 Question Id : 146587336 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Arrange the following steps in the CORRECT order by which one can insert a video in a Microsoft PowerPoint 2013 slide from YouTube.

a) Go to the 'Insert' tab -> Click 'Video' > Select 'Online Video'.
b) Click the slide that you want to add a video to.
c) Select the video from the search results -> Click 'Insert'.
d) In the 'Search YouTube' box, type the name of the video that you want to insert -> Press Enter.
e) A rectangular-shaped video is placed on your slide, which you can move and resize as you like -> To preview your video on your slide, right-
click the rectangular-shaped video -> Select 'Preview' -> Click the play button on the video.
f) Switch to the 'Playback' tab of the ribbon to make choices about how and when the video plays
Options :
1465871341.  a); b); d); c); e); f)
1465871342.  b); a); d); c); e); f)
1465871343.  b); a); c); d); f); e)
1465871344.  b); d); c); a); e); f)
  
Question Number : 36 Question Id : 146587336 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत चरणो ंको सही �म म� �व��थत कर�  िजससे कोई ��� YouTube से Microsoft PowerPoint 2013 �ाइड म� वीिडयो इ�ट� कर सकता है।

a) 'Insert (इ�ट�)' टैब पर जाएँ -> 'Video (वीिडयो)' पर ��क कर�  -> 'Online Video (ऑनलाइन वीिडयो)' चुन�।
b) उस �ाइड पर ��क कर�  िजससे आप एक वीिडयो जोड़ना चाहते ह�।
c) सच� �रज�्स म� से वीिडयो का चयन कर�  -> 'Insert (इ�ट�)' पर ��क कर�।
d) 'Search YouTube' बॉ� म�, उस वीिडयो का नाम िलख� िजसे आप इ�ट� करना चाहते ह�, -> एंटर दबाएँ।



e) कोई आयताकार वीिडयो आपकी �ाइड पर रखा गया है, िजसे आप �थानांत�रत कर सकते ह� और जैसा चाह� वैसा आकार दे सकते ह� -> अपनी �ाइड पर
अपने वीिडयो का �ी�ू देखने के िलए, आयताकार वीिडयो पर राइट-��क कर�  -> '�ी�ू' का चयन करके -> वीिडयो का �े बटन पर ��क कर�।
f) वीिडयो कैसे और कब �े होता है, इसके बारे म� चुनाव करने के िलए �रबन के 'Playback (�ेबैक)' टैब पर जाएँ।
Options :
1465871341.  a); b); d); c); e); f)
1465871342.  b); a); d); c); e); f)
1465871343.  b); a); c); d); f); e)
1465871344.  b); d); c); a); e); f)
  
Question Number : 37 Question Id : 146587337 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
What is the full form of GUI?
Options :
1465871345.  Global User Interface
1465871346.  Geographical User Interface
1465871347.  Graphical User Interface
1465871348.  Graphical User Intervention
  
Question Number : 37 Question Id : 146587337 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
GUI का पूण� �प �ा है?
Options :
1465871345.  Global User Interface (�ोबल यूजर इ�रफेस)
1465871346.  Geographical User Interface (�ो�ािफकल यूज़र इंटरफ़ेस)
1465871347.  Graphical User Interface (�ािफकल यूज़र इंटरफ़ेस)
1465871348.  Graphical User Intervention (�ािफकल यूजर इ�रव�शन)
  
Question Number : 38 Question Id : 146587338 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



State whether the following statements are TRUE or FALSE.

a) OpenOffice Writer is not a freeware.
b) Microsoft Word from the Microsoft Office suite is a freeware.
c) Windows XP is an open-source operating system.
Options :
1465871349.  a) – False; b) – False; c) – False
1465871350.  a) – True; b) – False; c) – False
1465871351.  a) – True; b) – False; c) – True
1465871352.  a) – False; b) – True; c) – False
  
Question Number : 38 Question Id : 146587338 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
बताएं िक िन�िल�खत कथन सही ह� या गलत।

a) OpenOffice Writer एक �ीवेयर नही ंहै।
b) Microsoft Office सूट का Microsoft Word एक �ीवेयर है।
c) Windows XP एक ओपन सोस� ऑपरेिटंग िस�म है।
Options :
1465871349.  a) – गलत; b) – गलत; c) – गलत
1465871350.  a) – सही; b) – गलत; c) – गलत
1465871351.  a) – सही; b) – गलत; c) – सही
1465871352.  a) – गलत; b) – सही; c) – गलत
  
Question Number : 39 Question Id : 146587339 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



Options :
1465871353.  a – ii; b – iii; c – iv; d – i
1465871354.  a – iv; b – iii; c – ii; d – i
1465871355.  a – ii; b – i; c – iv; d – iii
1465871356.  a – iii; b – ii; c – iv; d – i
  
Question Number : 39 Question Id : 146587339 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0

Options :
1465871353.  a – ii; b – iii; c – iv; d – i
1465871354.  a – iv; b – iii; c – ii; d – i



1465871355.  a – ii; b – i; c – iv; d – iii
1465871356.  a – iii; b – ii; c – iv; d – i
  
Question Number : 40 Question Id : 146587340 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following languages is NOT used for client-side validation?
Options :
1465871357.  JavaScript
1465871358.  PHP
1465871359.  ASP
1465871360.  ASP.NET
  
Question Number : 40 Question Id : 146587340 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
�ाइंट-साइड वेिलडेशन (�माणन) के िलए िन�िल�खत म� िकस भाषा का �योग नही ंहोता है?
Options :
1465871357.  JavaScript (जावा ���)
1465871358.  PHP
1465871359.  ASP
1465871360.  ASP.NET
  
Question Number : 41 Question Id : 146587341 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



Options :
1465871361.  a – ii; b – i; c – iv; d – iii
1465871362.  a – i; b – ii; c – iv; d – iii
1465871363.  a – ii; b – iii; c – iv; d – i
1465871364.  a – ii; b – i; c – iii; d – iv
  
Question Number : 41 Question Id : 146587341 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0

Options :
1465871361.  a – ii; b – i; c – iv; d – iii
1465871362.  a – i; b – ii; c – iv; d – iii
1465871363.  a – ii; b – iii; c – iv; d – i



1465871364.  a – ii; b – i; c – iii; d – iv
  
Question Number : 42 Question Id : 146587342 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
PowerShell is a task automation and configuration management framework from ______.
Options :
1465871365.  Microsoft
1465871366.  IBM
1465871367.  Sun Microsystem
1465871368.  HP
  
Question Number : 42 Question Id : 146587342 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
पॉवरशेल ________ का एक टा� ऑटोमेशन और कॉ��फ़गरेशन मैनेजम�ट �ेम-वक�  है।
Options :
1465871365.  माइ�ोसॉ�
1465871366.  IBM
1465871367.  सन माइ�ोिस�म
1465871368.  HP
  
Question Number : 43 Question Id : 146587343 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
What is Shell Script in Linux?
Options :
1465871369.  Computer program designed to be run by the Linux shell
1465871370.  GUI based computer program for Linux Shell
1465871371.  Linux administrator command
1465871372.  Linux Kernel Interface



  
Question Number : 43 Question Id : 146587343 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िलन� म� शेल ��� �ा होता है?
Options :
1465871369.  िलन� शेल �ारा संचािलत कं�ूटर �ो�ाम
1465871370.  िलन� शेल के िलए GUI आधा�रत कं�ूटर �ो�ाम
1465871371.  िलन� एडिमिन�� ेशन कमांड
1465871372.  िलन� कन�ल इंटरफ़ेस
  
Question Number : 44 Question Id : 146587344 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0

Options :
1465871373.  a – ii; b – i; c – iv; d – iii
1465871374.  a – i; b – ii; c – iv; d – iii
1465871375.  a – ii; b – iii; c – iv; d – i
1465871376.  a – ii; b – iv; c – i; d – iii
  
Question Number : 44 Question Id : 146587344 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



Options :
1465871373.  a – ii; b – i; c – iv; d – iii
1465871374.  a – i; b – ii; c – iv; d – iii
1465871375.  a – ii; b – iii; c – iv; d – i
1465871376.  a – ii; b – iv; c – i; d – iii
  
Question Number : 45 Question Id : 146587345 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In security, _________ is a set of circumstances that has the potential to cause loss or harm.
Options :
1465871377.  threat
1465871378.  vulnerability
1465871379.  control
1465871380.  repudiation
  
Question Number : 45 Question Id : 146587345 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
सुर�ा म�, ________ ऐसी प�र��थितयो ंका समूह है िजसम� �ित या नुकसान की संभावना होती है।
Options :



1465871377.  �ेट(threat)
1465871378.  व�नरिबिलटी (vulnerability)
1465871379.  कंट� ोल (control)
1465871380.  अ�ीकरण (repudiation)
  
Question Number : 46 Question Id : 146587346 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
A valid email address must contain:
Options :
1465871381.  @
1465871382.  #
1465871383.  http
1465871384.  www
  
Question Number : 46 Question Id : 146587346 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िकसी मा� ईमेल पते म� िन�िल�खत म� से िकसका होना ज़�री है? 
Options :
1465871381.  @
1465871382.  #
1465871383.  http
1465871384.  www
  
Question Number : 47 Question Id : 146587347 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
An email address consists of which two parts?
Options :
1465871385.  Email prefix and email domain



1465871386.  Name and country
1465871387.  Data and country
1465871388.  Name and company
  
Question Number : 47 Question Id : 146587347 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िकसी ईमेल पते म� दो भाग कौन-कौन से होते ह�?
Options :
1465871385.  ईमेल �ीिफ� और ईमेल डोमेन
1465871386.  नाम और देश
1465871387.  डाटा और देश
1465871388.  नाम और कंपनी
  
Question Number : 48 Question Id : 146587348 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The memos in the RFC document series contain technical and organizational notes about the internet. What is the full form of RFC?
Options :
1465871389.  Request For Comments
1465871390.  Request For Contents
1465871391.  Recall For Comments
1465871392.  Received For Comments
  
Question Number : 48 Question Id : 146587348 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
RFC द�ावेज़ �ंृखला के मेमो म� इंटरनेट के बारे म� तकनीकी और संगठना�क नोट होते ह�। RFC का पूण� �प �ा होता है?
Options :
1465871389.  �र�े� फॉर कम�ट्स (Request For Comments)
1465871390.  �र�े� फॉर कंट�ट्स (Request For Contents)



1465871391.  �रकॉल फॉर कम�ट्स (Recall For Comments)
1465871392.  �रसी�ड फॉर कम�ट्स (Received For Comments)
  
Question Number : 49 Question Id : 146587349 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The File Transfer Protocol is used for:
Options :
1465871393.  only to uploading a file to a server
1465871394.  only downloading a file from server
1465871395.  uploading a file to a server and downloading a file from the server
1465871396.  process communication
  
Question Number : 49 Question Id : 146587349 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
फ़ाइल ट� ांसफर �ोटोकॉल का उपयोग िन�िल�खत म� से िकसके िलए िकया जाता है?
Options :
1465871393.  केवल सव�र पर फ़ाइल अपलोड करने के िलए।
1465871394.  केवल सव�र से फाइल डाउनलोड करने के िलए।
1465871395.  फ़ाइल को सव�र पर अपलोड और सव�र से फ़ाइल डाउनलोड करने के िलए।
1465871396.  �ि�या संचार (�ोसेस क�ुिनकेशन) के िलए।
  
Question Number : 50 Question Id : 146587350 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which type of network would you suggest for networking of a school building?
Options :
1465871397.  WAN
1465871398.  LAN
1465871399.  MAN



1465871400.  PAN
  
Question Number : 50 Question Id : 146587350 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
िकसी �ूल िब��ंग की नेटविक� ग के िलए आप िकस �कार के नेटवक�  का सुझाव द�गे?
Options :
1465871397.  WAN
1465871398.  LAN
1465871399.  MAN
1465871400.  PAN


